
The meter bridge shown in photo is one of the optional accessories.

Application Guide Version 2

Audio Mixer
WR-DA7



Limit of Liability/Disclaimer of Warranty: The author, Audio Video Systems Division of

Matsushita Communication Industrial Co., Ltd has used its best efforts in preparing this book.

However, Audio/Video Systems Division of Matsushita Communication Industrial Co., Ltd makes

no representation or warranties with respect to the accuracy or completeness of the contents of

this book and hereby specifically disclaims any implied warranties or merchantability or fitness for

any particular purpose and shall in no event be liable for any loss of profit or any other commer-

cial damage, including but not limited to special, incidental, consequential, or other damages.

TRADEMARKS
Audio Video Systems Division of Matsushita Communication Industrial Co., Ltd has made every

effort to supply trademark information about company names, products, and services mentioned

in this document. Trademarks indicated below were derived from various sources. All products or

services not listed below are the trademarks, service marks, registered trademarks or registered

service marks of the respective owners.

ADAT is a registered trademark of Alesis Corporation

TDIF is copyrighted by TEAC Corporation and TASCAM is a registered trademark of TEAC

Corporation

IBM is a registered trademark of International Business Machines Corporation

Mac is a registered trademark of Apple Computer, Inc.

Mark of the Unicorn is a trademark of Mark of the Unicorn, Inc.

2



3

Table of Contents
1. Introduction ......................................................................................... 4

2. Notes for connections with peripheral equipment............................. 5

2.1 Wordclock ....................................................................................... 5

2.2 Installing and using option cards with the WR-DA7 ...................... 5

2.3 ADAT, BRC....................................................................................... 8

2.4 DA-98, 88, 38 .................................................................................. 9

2.5 DAT (with AES/EBU or S/PDIF I/O) ................................................11

2.6 Digital timepiece.............................................................................11

2.7 Expansion Software (Macintosh Version).......................................11

3. WR-DA7 system applications................................................................15

3.1 Example of systems for ADAT(1unit)

(When a timecode is recorded on the tapetrack) .........................15

3.2 Example of systems for ADAT (3units) and BRC............................17

3.3 Example of systems with Two WR-DA7 in tandem 

with 4 ADATs and BRC...................................................................20

3.4 Example of systems with 3 DA-88s .................................................24

3.5 Example of systems for WR-DA7 tandem connections 

with DA-98(1unit) and DA-38(3units) ...........................................27

3.6 Example of systems for analog 16-track recorder(1unit) ..............30

3.7 Example of systems for Digital Video Recorder (1unit) ................32

3.8 Example of systems for VTR (1unit), ADAT (1unit),

and BRC .........................................................................................34

3.9 Example of systems for VTR (1unit) and DA-98 (1unit) ................37

3.10 System Example of Pro Tools .......................................................40

3.11 System Example of PC Sequencer (Performer)............................43

3.12 System Example of Tandem-Connection 

to PC Sequencer (Performer) ......................................................46

3.13 System Example of AKAI DR8 (1 unit) .........................................50

3.14 Connection to MAX (Macintosh) expansion software ................52

3.15 Connection to MAX (Macintosh) expansion software 

and Other Sequence Software .....................................................54

3.16 Tandem-Connection to MAX (Macintosh) expansion software ...57

3.17 Tandem-Connection to MAX (Macintosh) expansion software

and Other Sequence Software .....................................................60



4

1. Introduction

This Application Guide supplies examples for interfacing the WR-DA7 with commonly used

peripheral recording equipment. This guide’s diagrams provide the necessary connections and

the methods for establishing proper system operation.
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2. Notes for connections 
with peripheral equipment

2.1 Wordclock

The WR-DA7 as wordclock master

The DA7 has an internal wordclock generator that provides a timing reference for the external

(digital) audio devices connected to it. This is neither MIDI nor SMPTE timecode. You can set the

internal generator to synchronize to either 44.1 or 48K, selectable from The [D-I/O>INPUT SET]

window.

When multiple digital audio devices are used, it becomes necessary to synchronize the audio sig-

nals with a single reference timing signal or master wordclock source. In a system where all of the

digital audio devices share a common wordclock it is essential that all of the devices be turned on

even if they are not being used.

The WR-DA7 as wordclock slave

The DA7 can be slaved to an external wordclock source, to accomplish this you must go to the [D-

I/O>INPUT SET] window. Here you can choose Wordclock In [WCK IN], Video Sync In [V SYNC],

2 track A input [2TR IN A] and Slot 1,2 or 3.

For example: it is possible to select the WR-AESS card as the wordclock source of the WR-DA7. 

The DA7 can be synchronized with the digital audio signals being input on Channels 1/2 of the

WR-AESS card. However, when no input is present on Channels 1/2 an UNLOCK status will be dis-

played. The wordclock synchronization with the other channels will not be realized either.

If the word clock is set incorrectly (for example, a system where multiple equipment units are set

as the wordclock master), noise (usually in the form of clicks and pops) may become audible. It is,

therefore, necessary that all of the slave units be synchronized with the wordclock master unit. 

2.2 Installing and using option cards with the WR-DA7:

Be sure to install all of the Option Cards with the power of the DA7 turned OFF. Set the

Dipswitches on the card accordingly for the type of devices being connected. 

Insert the card into the WR-DA7. Install all of the supplied mounting screws (for proper ground-

ing) securely to the DA7’s chassis. 

WR-TDIF: Set the dipswitches, or switches on the card, according to the devices 

being connected. 

When connecting a DA-38 or DA-98 (SW1) ON, (SW2) OFF

When connecting a DA-88 (SW1) OFF, (SW2) OFF
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WR-AESS: Select the switch (AES/EBU, S/PDIF) on the card, according to the devices being

connected. It is possible to select settings for each pair of channels 1/2, 3/4, 5/6,

and 7/8.

This switch is used for switching the electrical signal not for format

change. 

WR-TNDM: The Tandem card is for use in Slot 3 (only) of both mixers. 

WR-SMPT: SMPTE Card, carefully follow the steps to install the WR-SMPT according to the

instructions in the owner’s manual.

Wordclock 

For proper wordclock connections, it is necessary to terminate the last device in the wordclock

chain. The WR-DA7 allows ON/OFF of the 75-Ohm terminator on the wordclock input. 

ON: Is selected when the WR-DA7 is used as a wordclock master or as a slave at the end of

the wordclock connections (terminated at 75 Ohm). (A clock output synchronized with DA7

is generated at the word clock’s output.) 

OFF: Is selected when the WR-DA7 is used as a slave, the wordclock input entered in the WR-

DA7 is transmitted as a through output. 

MIDI 

To select the port for MIDI communication, press the MIDI switch until the [MIDI>SETUP] screen

appears. Then select the port for [Gen.Rx] and/or [Gen.Tx] from either MIDI or TO PC. 

The MIDI channels assigned to Gen.Rx and Gen.Tx function serve as a device ID number of the

WR-DA7 during reception or transmission of MIDI data. (Select OMNI to receive messages on all

MIDI channels.) For selecting the MIDI channels, press the MIDI switch until the MIDI SETUP

screen appears. Then, select a channel for Gen.Rx or Gen.Tx. 

To control external equipment using MIDI Machine Control commands, set the MMC port to MIDI

and assign a MIDI channel. The MIDI channel needs to be the same as the external equipment

being controlled. To make the setting, press the MIDI switch until the MIDI SETUP screen appears.

Then, set up the MMC port and CH (MIDI channel). 

Timecode 

The WR-DA7 can record and playback automation in synchronization with external timecode. The

WR-DA7 can be synchronized to MIDI timecode (MTC), MIDI clock, and SMPTE timecode (using

the option card WR-SMPT). To select the timecode settings, press the AUTOMATION button until

the SETUP screen appears. Select the appropriate timecode from the TIME BASE area in

Automation EXECUTE window, using the parameter dial select MTC, MIDI CLK, or SMPTE then

push the ENTER key. 

When MTC is used, select a port to be used for receiving the MIDI data. The MTC receive port can

be selected by pressing the MIDI switch until the MIDI SETUP screen appears. Then, select the

MTC port from MIDI or TO PC. 



7

Tandem connection

Make all connections with the mixers turned OFF. 

You will need the following cables and cards: 

(2) WR-TNDM cards, 

(1) Tandem cable (part # DA/DB-DB: Available in the USA), 

(1) MINI DIN 8-Pin Serial cable (Macintosh Printer Cable), or (2) MIDI cables, 

(1) 75 ohm BNC-BNC wordclock cable (part # DA/BNC: Available in the USA). 

Set up the consoles as master and slave and make the tandem connections for the mixers accord-

ingly. 

MASTER: When used with the tandem master unit. 

SLAVE: When used with the tandem slave unit. 

To connect two WR-DA7 mixers in Tandem, install a WR-TNDM card in Slot 3 of each mixer (with

the mixers powered OFF).

Select MASTER/SLAVE on the front panel of each WR-TNDM card.

For proper wordclock synchronization between the two mixers, connect the WORD CLOCK OUT

terminal of the master unit to the WORD CLOCK IN terminal of the slave unit (75 ohm terminate

ON). To set the wordclock of the slave unit, press the D-I/O switch until the INPUT SETUP screen

appears. Then, set the SOURCE SELECT to WCK IN. 

To establish communications between the Tandem mixers connect the specified serial cable

(Macintosh cross cable printer cable) or MIDI cable between the RS-422/485 and MIDI ports on

each of the mixers (TO PC or MIDI IN/OUT) must be selected to establish communications.

Communication setting are selected by pressing the D-I/O switch to display the TO SLOT screen of

D-I/O page then select the port from either TO PC or MIDI. In the case of TO PC connection, the

setting should be set so that the baud rates of the master and slave units are set the same on each

of the mixers (a baud rate of 125k is recommended). For baud rate setting, press the MIDI switch

to display the MIDI SETUP screen then select the necessary baud rate. 

To establish tandem connections, press the D-I/O to display the TO SLOT screen of D-I/O and

switch the TANDEM setting to ON in Slot 3. 

Press the MIDI button in the Set Up section on the Top Panel of the DA7 to select the MIDI SET UP

screen. In the PORT SELECT Area of the SERIAL I/O SETUP section, select TO PC. Set the BAUD

RATE for both consoles to 125K by highlighting  the area with cursor and using dial to select the

rate. In the MIDI SETUP area, make sure the MIDI channels are set to the SAME channels for

Gen.Rx/Gen.Tx for BOTH consoles. Set Gen.Rx/Gen.Tx PORT to TO PC.

Press the D-I/O to display the TO SLOT Window. If TANDEM is not selected in the

NORMAL/INSert/TANDEM area, select  it. Below the “SLOT 3 TANDEM” area, make sure TANDEM

is set to ON. Select AUTO in the OFFSET DELAY section. Make sure the PORT SELECT is set to TO

PC. The CONNECT area will read SLOT NG or DATA NG until the SLAVE console is configured.

On the Slave console, follow the same procedures. The CONNECT area in the TO SLOT window

will read SLOT NG or DATA NG until data is sent between the consoles. Turning a channel to ON

will initiate the data flow, and the CONNECT prompt in the D-I/O TO SLOT screen  will then read

OK on both DA7s (this can take up 5 seconds).
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2.3 ADAT, BRC 

Connections 

To connect an ADAT with the WR-DA7 digitally, the WR-ADAT option card is needed to connect the

optical cables. Install the card (with the mixer turned OFF) and screw the option card securely

into place to ensure proper grounding. To use the ADAT’s DIGITAL INPUT press the DIGITAL IN

button on the ADAT to display DIGITAL IN. (Do not switch the DIGITAL I/O button on the BRC to

ON, this is for transferring data between ADATs and may cause unsuspected results.)

To select the ADAT’s wordclock source press the SET LOCATE and DIGITAL IN simultaneously, the

ADAT will display ‘int’ for internal word clock or ‘digi’ for external word clock. 

To connect multiple ADAT units, each unit is required to make ID setting. The ID order of the

ADAT are set up automatically according to how the sync cable are connected, starting with 1, in

the order of ADAT SYNC cable connections from SYNC OUT to SYNC IN. (The same ID is used

even when the BRC is connected.) 

The ADATs must be powered-up before the BRC. The BRC should be turned on last. 

Wordclock 

If the ADAT is being used as the wordclock master set the ADAT wordclock to INT. The WR-DA7

functions as an ADAT SLAVE. The WR-DA7 wordclock settings can be set by pressing the D-I/O

switch to display the INPUT SET window of the D-I/O setup section. Then; the SOURCE SELECT is

used to select the slot where the WR-ADAT card is inserted. Cursor to that Slot and press Enter.

LOCK should be displayed in the adjacent window.

When the ADAT and the BRC are in the wordclock master mode, the sampling rate is determined

by selecting the Fixed Mode to 48kHz. 

To set the sampling rate at 44.1kHz, select the Variable Mode and press the PITCH DOWN switch

on the front panel. Make the setting -147 cent (‘44.1’ display). 

For the ADAT-XT, this setting is done with the CLOCK SELECT switch on the front panel and the

ADAT is set to INT clock.

To use the WR-DA7 as the wordclock master, press the CLOCK SELECT switch on the front panel

of ADAT XT to set up the ADAT XT to DIG to slave to an external clock source. When using a BRC

as ADAT master controller it is recommended that the BRC be set to slave to the DA7. To do this

press the Edit button then the External Sync button on the BRC and select 48 kHz input using the

arrow keys. Press the Edit button to exit this mode. Make sure the EXTERNAL SYNC mode is

selected (the external sync button will light green). 

MIDI 

To use the ADAT’s MMC operations from the DA7 with a BRC, it is necessary that the transmitting

MIDI channel of the WR-DA7 match the MIDI channel of MMC to be received on the BRC. 

For MIDI setting on the BRC, press the MIDI/UTIL to display #11:

MIDI Device screen and set up the value of (MIDI channel of the

MMC command to be output from the WR-DA7) – 1. 

Set up ‘ALL’ if it is necessary for the BRC to receive the MIDI messages from other MIDI equip-

ment. 
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When a MIDI message is received at the MIDI IN terminal of the BRC it is immediately transferred

as a through output from the MIDI OUT terminal. To send MIDI data through the BRC, press the

MIDI/UTIL switch several times on the front panel of the BRC to display the 1:MIDI ECHO screen,

then select ‘ON’ using the arrow keys. 

Timecode 

To generate MTC from the BRC, press the EDIT switch and then press the GEN SYNC switch until

the MIDI screen appears. Select MTC, and turn the GEN SYNC switch to ON. 

To generate SMPTE timecode from the BRC, press the EDIT switch and then press the GEN SYNC

switch until the SMPTE screen is displayed. Set to -10dB and turn the GEN SYNC switch to ON. 

To generate timecode from the BRC when the ADAT is in FF/REW operation, press the MIDI/UTIL

switch on the front panel of the BRC until #8 is displayed. Output Rew/FF SMPTE AND MTC:

Screen, and select to ‘ON.’ 

2.4 DA-98, 88, 38 

Connections 

When making connections between the DA98, 88, 38 and the WR-DA7, use the WR-TDIF option

card and make the connections using the Panasonic part # DA/DB-TDIF(Available in the USA) or

use Part # PW-88D (1m) or PW-88D-L (5m) made by TASCAM.

Set the dipswitches on the WR-TDIF card, according to the model of DA-98, 88, or 38. 

(SW1) ON, (SW2) OFF: When the DA-38 or DA-98 is connected. 

(SW1) OFF, (SW2) OFF: When the DA-88 is connected. 

To receive a digital signal on the DA-98, 88, or 38, press the DIGITAL IN switch on the front panel

to select the ‘DIGITAL IN’ indicator. 

When multiple DA98, 88, or 38s are connected, set the machine ID to ‘1’ (‘0’ in the case of DA-

88s) on the first unit (master unit). The machine IDs of the slave units should be set sequentially,

starting with ‘2’ subsequent to the units connected using the PW-88S Sync cables. 

The machine ID for the DA-88 is the number added with (ID No. of

the rear panel switch) + 1. 

When multiple DA98, 88, 38s are connected using the PW-88S Sync cables, the terminator included

with the Sync cables should be connected to the Sync OUT terminal of the last device. 

Wordclock 

When the DA-98, 88, or 38 is used as the wordclock master, the wordclock for the DA-98, 88, or 38

is set to ‘INT.’ The Wordclock selection is made by pressing the CLOCK switch on the front panel

to select ‘INT.’ 

To set the clock selection to INT, WORD, or VIDEO press the CLOCK

switch on the front panel of the DA-98, 88, and 38, the machine IDs

of the DA-98, 88, and 38 are required to be set as 

specified below. 

DA-98, 38: ID=1 

DA-88: ID=0 

To use a DA-88 as the wordclock master, connect a 75 ohm BNC to BNC cable from the WORD
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SYNC OUT terminal of the DA-88 to the WCK IN terminal of the WR-DA7. Then press the D-I/O

switch of the WR-DA7 several times in order to display the INPUT SET screen of the D-I/O window.

Then, select the SOURCE SELECT to ‘WCK IN.’ 

When the DA-98 or 38 is the wordclock master, the slot where the WR-TDIF card is inserted can be

selected as the wordclock source, in addition to the above-mentioned WCK IN. For WR-DA7 word-

clock setting, press the D-I/O switch several times to display the INPUT SET screen of the D-I/O

window. Then, select the SOURCE SELECT to the SLOT where the WR-TDIF card is installed. 

The sampling rate settings for the DA-98, 88, 38 is dependent on the format of the tape being

used. Therefore, the sampling rate is automatically selected according to the sample rate on the

tape. 

When the WR-DA7 is the wordclock master, the BNC cable should be connected from the WORD

CLOCK OUT terminal of the WR-DA7 to the WORD SYNC IN terminal of the DA-98 or 38. Select

WORD by pressing the CLOCK switch on the front panel of the DA-98 or 38. 

When Connecting a DA-88 the WR-DA7 must function as the slave unit. 

MIDI 

For MMC control from the WR-DA7 to the DA-98, select Menu Group 3 in the DA-98 screen and

select the Ctrl Prt (Control Protocol) to ‘MIDI.’ 

For the MIDI ID of MMC being received on the DA-98, select Menu Group 7 in the DA-98 screen

and set the MIDI ID to the same number of the MIDI channel of the MMC to be sent from the WR-

DA7. 

Install the SY-88 Sync board to perform MMC operation from the 

WR-DA7 to the DA88. 

For SY-88 Sync board setting, set the MODE dip switch 2 on the rear panel at 0 (OFF) so that con-

trol from external equipment can be accomplished through the MIDI port. 

Timecode 

When playing back the timecode recorded on the tape from the DA-98, select Menu Group 5 in

the DA-98 screen and set Tape (ABS) with OutTc Src. 

To generate the MTC output from the DA-98, select Menu Group 7 on the DA-98 screen and set

the output to ‘ON’ with MTC Out. To generate the MTC output while the DA-98 is in FF/REW oper-

ation, set fast to ‘ON.’ To generate the MTC output when the DA-98 is stopped, set Stop to ‘ON.’ 

To generate the timecode output from the DA-98 in synchronization with the digital audio data,

select Menu Group 5 in the DA-98 screen and set  ‘Digital’ with OutTc Tmg. 

When an SY-88 Sync board is installed in the DA-88, it is possible to generate SMPTE timecode and

MTC (MIDI timecode) from the DA-88. 

For proper SY-88 Sync board setting, set the MODE dip switch 6 on the rear panel to 1 (ON) so

that the timecode recorded on the tape of the DA-88 can be converted to MTC. 

If the MODE dip switch 6 is set to 0 (OFF), the timecode received in the TIME CODE IN terminal

of the DA-88 is then outputted after being converted to MTC. 

To generate timecode from the DA-88 in synchronization with the digital audio data set the MODE

dip switch 5 on the SY-88’s real panel to 0 (OFF). 
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2.5 DAT (with AES/EBU or S/PDIF I/O)

To record and playback using the DAT Recorder as the wordclock master and the WR-DA7 as a

slave, connect the DAT to the REC OUT and 2TR IN terminals of the WR-DA7. Press the D-I/O

switch on the WR-DA7 to display the INPUT SET screen on the D-I/O so that synchronization is

secured with the digital audio signal of the DAT. Then, set the SOURCE SELECT to  ‘2TR IN A.’ 

To record and playback using the WR-DA7 as the wordclock master and the DAT as the slave, con-

nect the DAT to the REC OUT and 2TR IN terminals of the WR-DA7, and select a wordclock source

to another device other than the DAT connected to 2TR IN A. 

To record with the S/PDIF output of the WR-DA7 connected to the DAT, please note that some DAT

units may not operate in the normal recording mode. In this case, the connection between the

WR-DA7 and the DAT should be made using the AES/EBU digital audio terminals. 

2.6 Digital timepiece 

Note the following: when setting up a system using the Mark of the Unicorn Digital Timepiece

(DTP). 

When an ADAT is connected to the DTP using an ADAT Sync cable and the DTP is the master

machine the ADAT is synchronized using the timecode being generated by the DTP. Therefore, the

timecode of the DTP is kept unchanged even though the operation of PLAY and REC is performed

on the ADAT. For this reason, the ADAT cannot be synchronized with the timecode and normal

operation cannot be performed. 

When the DA-98, 88, or 38 is controlled by the DTP, the DTP functions as the master unit and the

others operate as the slave. Therefore, set the machine ID to another ID other than ID=1 for the

DA-98 or 38, set at something other than ID=0 for the DA-88. When the CHASE switch of the DA-

98, 88, or 38 is set to ON, each unit works as a slave unit to the DTP and all other units run in syn-

chronization with the DTP. 

When the DTP is used as the MIDI interface with MMC from the WR-DA7 for the ADAT or the DA-

98, 88, or 38 connected through the DTP and the SYNC cable, the following operation takes place: 

FF/REW operation: Stops where the timecode makes leading of less than

10 seconds. 

REC operation: REC is effected upon the cancellation of the record

standby condition. No recording is performed. 

When using the VIDEO OUT of the DTP as the wordclock source for the WR-DA7, the WR-DA7 may

be in a mode where the VIDEO frame rate of the DTP cannot be recognized correctly. Recognition

is not possible when the DTP frame rate is set to any rate other than 59.94 (frames/second). 

2.7  Expansion Software (Macintosh Version)

Connection

To connect a personal computer (Macintosh), in which RAMSA MAX software is installed, to the

WR-DA7, use the recommended cable (ImageWriter printer cable) to connect the serial port

(modem port or printer port) on the Macintosh computer to the TOPC port on the WR-DA7.

.
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Normally, a Macintosh computer has two serial ports: modem and printer port.  RAMSA MAX soft-

ware permits connection of either of these ports to the WR-DA7.  To control one WR-DA7, the

modem port is normally used.  To control two WR-DA7s, connect the WR-DA7 (serving as the mas-

ter) to the modem port and the other one (serving as the slave) to the printer port.

For tandem communication between the two WR-DA7s, a MIDI cable must be connected from

MIDI IN on one WR-DA7 to MIDI OUT on the other.

MIDI

For communication with RAMSA MAX software, set it as follows:

When [Preference] is selected in the Edit menu, the Preference dialog appears on the screen.

Select [Port Setup] from it, and select the port (normally, the modem port) that is connected

to the WR-DA7 as [Automation Port].

Select a communication speed (Baud Rate) of either 62.5 k or 125 k.  Communication will be

faster at 125 k, however if the computer's operation is unstable, then select 62.5 k.

If you are using an external MIDI device, select [Use MIDI], then quit the expansion software, and

restart it. Now, select a MIDI device from the [MIDI Source, Echo MIDI to] box. In selecting a MIDI

device, the MIDI devices connected by the OMS must be recognized.  Start the OMS setup applica-

tion to have the MIDI devices recognized.  (Obtain the OMS setup application by downloading it,

(for example, from the home page of OPCODE.)

Set the WR-DA7 MIDI as follows:

Port Select: TOPC Baud Rate setting to 62.5 k or 125 k 

(to suit the expansion software settings)

Gen Tx:  TOPC MIDI CH 1

Gen Rx:  TOPC MIDI CH 1

PRG CHG:  TX-on RX-on THRU-off

CTRL CHG:  TX-on RX-on THRU-off NRPN-on

SYSTEM EX:  TX-on RX-on THRU-off

When using Tandem Connections, set the WR-DA7 as follows:

Press the DI/O button on the WR-DA7 to select the TO SLOT screen.

Set SLOT 3 to TANDEM ON and [Port Select] to MIDI.

Timecode

Expansion software allows MTC or SMPTE timecode to be received via the WR-DA7.  In this case,

set the expansion software as follows:

When [Preference] is selected in the Edit menu, the Preference dialog box appears in the screen.

Select the[Port Setup] and set the [Sync Source] to WR-DA7 Timecode.

Set the WR-DA7 as follows:

Press the Automation button on the 10 Key Pad until the EXECUTE screen appears.  Select

[MTC] for the [Timebase] and press the Enter button on the top panel of WR-DA7.

Press the MIDI button on the WR-DA7 until the MIDI Setup screen appears.  Set the MTC

receiving port to MIDI and set the THRU button of [OTHERS] to ON.

With the expansion software, MTC can be directly received from the Macintosh computer's serial

port, to which there are no WR-DA7 being connected, using OMS.
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Set the OMS as follows:

Start the OMS setup application.  If the OMS is not installed, it can be downloaded from the

manufactures web-site.

Select [OMS MIDI Setup] in the Edit menu.

Select the port (normally, the printer port) in which there's no WR-DA7 connected.  (In this

case, de-select [Modem] and [Run MIDI In background].)

If OMS is started for the first time, the MIDI devices connected to the computer must be rec-

ognized by the OMS.  Connect the MIDI devices being used to the printer port, and turn on

each MIDI device.  Then, execute [Easy Setup].  When the OMS recognizes all the MIDI

devices, save the settings of the OMS setup application, and quit the operation.

Set-up the expansion software as follows:

Select [Preference] in the Edit menu to open the Preference dialog-box.  Select [Port Setup]

and check [Use MIDI], quit the expansion software, and restart it.

Select [Preference] again in the Edit menu, and select MTC (OMS) for [Sync Source] from the

[Port Setup].  Select the MIDI device from the box in which the MTC is being sent.

Caution in setting Macintosh Computers

If Free MIDI is active in your Macintosh computer, the expansion software may become unstable in

operation and may conflict with OMS compatibility.  In this case, open the extension manager in

the Apple menu, and de-select Free MIDI, then restart the Macintosh computer.

RAMSA MAX software requires at least 8 MB of RAM.  (12 MB of RAM is recommended). If there is

sufficient RAM, select the icon for the expansion software, press the Command key and the charac-

ter key [I] and change memory size to select a RAM size of 12.

If the expansion software is unstable despite the above settings, open the extension manager in

the Apple menu, and turn off any unused applications.  It is known that applications that are relat-

ed to the serial ports and Apple Talk will conflict with the serial MIDI drivers (OMS, Free MIDI,

MIDI Manager, etc.).  Remove the drivers related to Quick Time using the Macintosh Extensions

Manager if it is not necessary to use them because they will impede the computer’s performance.

After changing these settings, the Macintosh computer must be restarted.
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3. WR-DA7 system applications 
3.1 Example of systems for ADAT (1 unit) 

(When a timecode is recorded on a tape track)

This system is used to record the SMPTE timecode on track # 8 of an ADAT. This timecode will be

used as the timecode reference for automation. 

Method of connection

With the mixer powered ‘OFF’ Insert the option card WR-ADAT (Slot 1) and WR-SMPTE in the dedi-

cated slot of the WR-DA7 and firmly fasten them to the mixer using the supplied screws. 

Connect the WR-ADAT card of the WR-DA7 to the DIGITAL IN/OUT terminal of the ADAT using an

optical cable and press the DIGITAL IN switch on the front panel of the ADAT to select the digital

input mode. 

The timecode is transferred by using the 8th Channel’s OUTPUT (RCA Pin Jack) of the ADAT

analogs output to the SMPTE IN (XLR: 1,3-GND, 2-SIGNAL) of the WR-DA7 using the (optional)

WR-SMPT installed. 

WR-DA7 setting 

Set the ADAT to the wordclock master and the WR-DA7 to the slave. 

In the INPUT SET screen of D-I/O of the WR-DA7, set the SOURCE SELECT to  ‘SLOT1.’ 

To display the SMPTE timecode received at the SMPTE IN, set the TIME BASE to  ‘SMPTE’ in the

EXECUTE screen of the AUTOMATION window. 

ADAT setting 

To use the ADAT as the wordclock master, press the CLOCK SELECT switch to select  ‘INT 48k’ or

‘INT 44.1k’ (for the ADAT-XT). 

For ADAT’s other than the ADAT-XT select to INT 48kHz, select the Fixed Mode. For INT 44.1kHz

setting, select the Variable Mode. Then, press the PITCH DOWN switch to select the setting at -

147cent (display of 44.1). 

During ADAT playback, there is no PLAY output while ALL INPUT on the front panel is ON. ALL

INPUT must be turned OFF. 
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3.2 Example of systems for ADAT  (3 units) and BRC 

This system is configured using 3 ADATs and a BRC connected using the ADAT Sync cables and the

three ADAT units are being remote-controlled from the BRC. In addition, it is possible to perform

automation synchronized to timecode (MTC or SMPTE) from the ADAT using the MIDI out of the

BRC, and having the ADAT controlled by MMC from the WR-DA7. 

Method of connection 

With the mixer powered OFF insert the option card WR-ADAT in Slot 1, 2, 3 of the WR-DA7 and fas-

ten them to the securely using the 4 screws. 

Connect the WR-ADAT card in the WR-DA7 to the DIGITAL IN/OUT terminals of the ADAT using an

optical cable and press the DIGITAL IN switch on the front panel of each ADAT to set up the digital

input mode. 

The BRC functions as the wordclock master. Connect the WORD OUT of the BRC to WORD

CLOCK IN of the WR-DA7 using a BNC cable and set the WR-DA7 wordclock termination to 75

Ohm=ON. 

For MIDI connection, connect the WR-DA7 to the MIDI IN/OUT of the BRC using a MIDI cable.

The MMC and MTC functions are now available. 

For the timecode, MTC is received using the MIDI connection. (Using the option card WR-SMPT, it

is possible to receive the SMPTE timecode. The SMPTE OUT (Phone Jack) of the BRC is connected

to the SMPTE IN (XLR: 1,3-GND, 2-SIGNAL) of the WR-DA7.) 

WR-DA7 setting To use the WR-DA7 as a slave unit, set the SOURCE SELECT to  ‘WCK IN’ in the

INPUT SET screen. (For synchronization with the ADAT card source, set SOURCE SELECT to

‘SLOT1.’) 

For MMC, set MMC PORT to  ‘MIDI’ in the MIDI SETUP screen. The MIDI channels should be set

to the same MIDI channel of the MMC being received on the BRC. 

To receive MTC on the DA7, set the MTC PORT to  ‘MIDI’ in the MIDI SETUP screen of the WR-

DA7. 

To have the MTC read out on the LCD screen, set the TIME BASE to  ‘MTC’ in the EXECUTE

screen of AUTOMATION SETUP. 

(For SMPTE timecode using the optional WR-SMPTE card, set the TIME BASE to  ‘SMPTE.’) 

ADAT setting 

For ADAT wordclock setting, connect a Sync cable from the BRC and turn on the power supply. At

that time, the setting is automatically set to  ‘EXT’ and the ADAT works as a slave to the BRC. 

The ADAT ID numbers are automatically set from 1, in the sequential order of the SYNC cable con-

nections from SYNC OUT to SYNC IN. 

The power supply of each ADAT should be turned on in the sequential order, starting with the last

unit located at the end of SYNC cable connections to the first unit. Finally, turn of the power sup-

ply of the BRC. 

The audio input of the ADAT needs to be selected into the digital input mode. Press, the DIGITAL

IN buttons on the front panel of each ADAT being used. 
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During ADAT playback there will be no playback while ALL INPUT is ON. ALL INPUT must be

turned OFF. 

BRC setting 

Select the Fixed Mode when the BRC is used as a word clock master and the sampling rate is set at

48kHz. Select the Variable Mode when the sampling rate is set at 44.1kHz. Press the PITCH DOWN

switch to make setting at -147cent ( ‘44.1’ display). 

For MTC setting, set MIDI in the GEN SYNC setting at  ‘MTC’ and turn on the GEN SYNC switch. 

For SMPTE setting set SMPTE in the GEN SYNC setting at  ‘-10dB’ and turn on the GEN SYNC

switch. 

To obtain a timecode output from the BRC during FF/REW operations in the ADAT, obtain a display

of 8: Output Rew/FF SMPTE & MTC: for ‘ON’ in MIDI/UTIL setting of the BRC. 

To accomplish MMC operation, there must be coincidence of the MIDI channel between the WR-

DA7 and the MMC’s MIDI channel of the BRC. On the BRC, obtain a display of 11: MIDI Device

screen by MIDI/UTIL setting. Set the value of ‘MIDI channel set for the WR-DA7 - 1.’ Otherwise, set-

ting should be set to ‘ALL.’ 
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3.3 Example of systems with Two WR-DA7 in tandem with 4 ADATs and BRC 

This is a 32-track digital recording system utilizing two WR-DA7’s connected in tandem along with

four ADAT units a BRC and ADAT Sync cable connections. The four ADAT units can be controlled

from the BRC. It is also possible to perform recording and playback synchronized to timecode

(MTC or SMPTE) generated from the ADAT through the MIDI interface of the BRC, and also con-

trol ADAT operation via MMC from the WR-DA7 is possible. 

Method of connection 

With the consoles turned OFF, insert the option cards of WR-ADAT in Slots 1 and 2 and install the

WR-TNDM in Slots 3 of the two WR-DA7 units and firmly fasten them to the back panel using the

screws supplied. 

Set the switch on the front of WR-TNDM card to MASTER for the WR-DA7 that is to being used as a

master unit. Set switch on the card to SLAVE of the WR-DA7 being used as a slave unit. 

Make the connections between the mixers using the recommended cables for proper tandem con-

nection. (Part No. DA/DB-DB: Available in the USA)) 

For serial or MIDI communications between the two WR-DA7 units, connect the master unit of the

WR-DA7 by selecting the TO PC (for serial) or the MIDI port of the slave unit using either the spec-

ified serial (Macintosh Printer Cable) or MIDI cables. 

For wordclock communication, make the connections between the WORD OUT of the BRC

(48kHz) and WCK IN of the WR-DA7 on the master unit, and connect between the WCK OUT of

the master unit to the WR-DA7 and WCK IN of the slave unit using BNC cables (Part No./BNC:

Available in the USA). 

Select he master mixer’s termination to 75 ohm OFF and set the slave unit to 75 ohm ON. 

Make the connections between the BRC and ADAT and between the ADAT units using the ADAT

SYNC cables, in the order off the ADAT’s to be used from SYNC OUT to SYNC IN. 

Connect the WR-ADAT card from the WR-DA7 to the DIGITAL IN/OUT terminal of the ADAT using

an optical cable (Part No. DA/TOS: Available in the USA) and press the DIGITAL IN switches on

each ADAT to select the digital-input mode. 

To make the MIDI connections, establish a loop for the two WR-DA7 units and the BRC, and make

MIDI cable connections from MIDI OUT to MIDI IN. This makes MMC and MTC operative. 

(It is possible to receive SMPTE timecode by using the WR-SMPT option card, by making the con-

nections from the SMPTE OUT (Phone Jack) of the BRC to SMPTE IN (XLR: 1,3-GND, 2-HOT) of

the WR-DA7.) 

WR-DA7 setting 

To use the WR-DA7 as a slave unit, set the SOURCE SELECT in the Input Set Window of the D-I/O

SETUP SECTION to  ‘WCK IN’ on the MASTER mixer. 

(For synchronization with the ADAT card source, set the SOURCE SELECT to  ‘SLOT1’ on the MAS-

TER mixer. Select  ‘WCK IN’ on the SLAVE mixer.) 

To maintain communications between the two WR-DA7 units, set the PORT SELECT to  ‘TO PC’ in

the SERIAL I/O SETUP area of the MIDI SETUP screen for both MASTER and SLAVE consoles. Then

set the baud rates at the same value. 
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For proper tandem connections, select the TANDEM setting to  ‘ON’ in the TO SLOT screen of the

D-I/O Input Setup Section. 

To operate MMC, set the MMC PORT to  ‘MIDI’ in the MIDI SETUP screen of the TANDEM MASTER

unit. In this case, the MIDI channel of MMC should be set at the same MIDI channel of MMC to be

received on the BRC. 

To send/receive the MIDI messages, set the PORT of Gen.Rx and Gen.Tx  to  ‘MIDI’ in the MIDI

SETUP screen. For the TANDEM SLAVE unit, set the SEND/RECEIVE of the various MIDI messages

to  ‘THRU.’ 

For MTC reception on the WR-DA7, set MTC PORT to  ‘MIDI’ in the MIDI SETUP screen of the

TANDEM Master unit. 

To obtain the MTC timecode display on the LCD screen set the TIME BASE to  ‘MTC’ in the

AUTOMATION EXECUTE screen of the Automation SETUP SECTION. 

(To use SMPTE timecode connect the WR-SMPTE card, and set the TIME BASE to  ‘SMPTE.’) 

ADAT setting 

For ADAT wordclock setting, connect a Sync cable from the BRC and turn on the power supply.

The setting is automatically set to  ‘EXT’ and the ADAT functions as a SLAVE to the BRC. 

The ADAT ID numbers are automatically set in the order of the SYNC cable connections from

SYNC OUT to SYNC IN. 

The power supply of each ADAT should be turned on first, then turn ON the power supply of the

BRC. 

To use the digital input of the ADAT, the DIGITAL IN button should be selected S on the ADAT’s

front panel. 

During ADAT playback if ALL INPUT is ON there will be no playback. ALL INPUT must be turned

OFF. 

BRC setting(BRC as the wordclock master)

Select the Fixed Mode when the BRC is used as the wordclock master and set the sampling rate to

48kHz. When the sampling rate is set to 44.1kHz select the Variable Mode and press the PITCH

DOWN switch to a setting of-147cent ( ‘44.1’ display). 

To obtain a through output of the MIDI message received on the BRC, press the BRC’s MIDI/UTIL

button repeatedly to display the MIDI ECHO screen and select the ON setting. 

For setting MTC, display the MIDI screen by pressing the GEN SYNC button to select a setting of

‘MTC.’ Press the EDIT button to exit the edit mode then, press the GEN SYNC button to enable

sync generation. 

For setting SMPTE, press the GEN SYNC button to display SMPTE: and use the UP/DOWN to select

‘-10dB’ then, press the EDIT button to exit the edit mode press the GEN SYNC switch to enable

SMPTE sync the LED will light. 

To obtain a timecode output from the BRC even during FF/REW operations of the ADAT, obtain a

display of 8: Output Rew/FF SMPTE & MTC: for  ‘ON’ in MIDI/UTIL setting of the BRC. 
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To accomplish MMC operation, the MIDI channel of the WR-DA7 and the MIDI channel of the BRC

must be set to the same channel. On the BRC, obtain a display of 11: MIDI Device screen by

MIDI/UTIL setting. Set the value of ‘MIDI channel set for the WR-DA7 - 1.’ Otherwise, the settings

should be set to  ‘ALL.’ 

BRC setting (BRC as the wordclock slave)

When using a BRC and ADAT with the DA7, it may be necessary to sync the BRC to the DA7’s inter-

nal wordclock generator.

1. Connect a 75 ohm (BNC) wordclock cable from the DA7’s wordclock output to the BRC’s 48

kHz input.

2. Press the EDIT then EXTERNAL sync buttons on the BRC and using the arrow keys, select 48

kHz INPUT. 

3. Press the EDIT button to go back to normal operation. Make sure the EXTERNAL sync button

is enabled (the button lights green).
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3.4 Example of systems with 3 DA-88s
This is a 24-track digital recording system that uses three DA-88’s. The DA-88 can generate SMPTE

timecode and MTC by using the optional SY-88 SYNC card installed into the DA-88. By using the

MIDI connections between the WR-DA7 and the DA-88, it is possible to perform MMC (MIDI

Machine Control) from the WR-DA7. 

Method of connection 

With the DA7 powered OFF insert the WR-TDIF (option card) in Slot 1, 2, 3 of the WR-DA7 and

firmly fasten them to the console with the supplied screws. Using the dip switches on the WR-TDIF

card make the proper setting for the DA-88 (SW1, 2 to OFF, OFF respectively). 

Connect the WR-TDIF card of the WR-DA7 to the DIGITAL I/O (TDIF-1) of the DA-88 using cable

(PW-88 DL) and press the DIGITAL IN switch of each DA-88 to select the digital input mode. 

Connect each DA-88 with the PW-88S SYNC cables in the sequential order from SYNC OUT to

SYNC IN. Connect the terminator to the SYNC OUT terminal of the DA-88. 

To use the DA-88 as the wordclock master, connect the WORD SYNC OUT of the DA-88 to WORD

CLOCK IN of the WR-DA7 using a BNC-BNC cable (Part # DA-BNC: Available in the USA) and select

the WR-DA7 termination at 75 ohm to ON. 

For MIDI connections, connect the WR-DA7 to MIDI IN/OUT of the SY-88 using a MIDI cable. It is

possible to use the MMC and MTC functions. 

For the timecode, MTC is received from the MIDI connection. (Using the option card WR-SMPT, it

is possible to receive the SMPTE timecode. In this example, the TIME CODE OUT (RCA Pin Jack)

of the DA-88 is connected to the SMPTE IN (XLR: 1,3-GND, 2-SIGNAL) of the WR-DA7.) 

WR-DA7 setting

The DA-88 functions as the wordclock master and the WR-DA7 as a slave unit. In the INPUT SET

window of the D-I/O area on the top panel of the WR-DA7 set the SOURCE SELECT to  ‘WCK IN’ 

(In the case of DA-98, 38 connections, synchronization with the SLOT and V-SYNC is also possi-

ble.)  

In regards to the MIDI channel of MMC set the MMC PORT to ‘MIDI’ in the MIDI SETUP screen

and make the proper MIDI channel settings. 

To receive MTC Timecode, set the MTC PORT to ‘MIDI’ in the MIDI SETUP screen. 

To display the MTC timecode on the LCD display, set the TIME BASE to ‘MTC’ in the EXECUTE

screen of AUTOMATION window. 

(To use the SMPTE timecode by connecting the optional WR-SMPTE card, and set the TIME BASE

to  ‘SMPTE.’) 
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DA-88 setting 

Since the DA-88 receives digital input data from the TDIF-1, press the DIGITAL IN switch on the

control panel. 

The machine ID number of the DA-88 is 0 for the wordclock master unit. These machine ID num-

bers are set at 0, 1, 2, and 3 using the rear rotary switch in the sequential order of the SYNC cable

connections attached from SYNC OUT to SYNC IN. 

(* For the DA-98 and 38, machine ID numbers are set at 1, 2, 3, 4 in the sequential order of the

connections.) 

Press the CHASE switch on the DA-88’s front panel with the machine IDs 2 and 3 to select CHASE

to ‘ON’ so that synchronization can be performed with the master DA-88. 

Set the sampling rate of the wordclock master unit to INT 48k or INT 44.1k. The sampling rate of

the DA-88 is automatically changed to the sampling rate of the tape being used. 

No playback is produced when ALL INPUT is ON; For playback, ALL INPUT should be set to OFF. 

For MMC control of the DA-88 from the WR-DA7, set the MODE dip switch #2 to 0 (OFF) on the

rear panel of the SY-88 in order to make the MIDI port effective. 

To produce a timecode output from the DA-88 in synchronization with the digital audio data set

the MODE dip switch #5 to 0 (OFF) on the rear panel of the SY-88. 

To output tape-recorded timecode from the DA-88, set the MODE dip switch 6 to 1 (ON) on the

rear panel of the SY-88 Sync board. 
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3.5 Example of systems for WR-DA7 tandem connections with DA-98 (1 unit)
and DA-38 (3 units) 

This is a 32-track digital recording configuration using two WR-DA7 mixers configured in tandem

with three DA-38’s being synchronized using the DA-98 as the master unit. Synchronization with

timecode (MTC or SMPTE) generated from the DA-98 and remote control operations function

using MMC generated from the WR-DA7. 

Method of connection 

With the mixers powered OFF, insert the WR-TDIF option cards in Slots 1and 2 and install the WR-

TNDM card in SLOT 3 of the two WR-DA7 units. For proper grounding fasten them to the console

using the supplied screws. 

Set the dip switches on the WR-TDIF card of the DA-98 and 38 (both SW1, 2 at ON, OFF). 

Set the rear switch of the WR-TNDM card to MASTER for the WR-DA7 that is to be used as a master

unit and set the slave WR-DA7 to SLAVE. 

Make the tandem connection between the WR-TNDM cards of the two WR-DA7 units using the pro-

prietary D-sub 25-pin Tandem Cable (Part # DA/DB-DB: Available in the USA).

For communication between the two WR-DA7 units, connect the master unit of the WR-DA7 with

the TO PC port of the slave unit using the recommended serial cable (Macintosh Printer cable). 

For wordclock connections, connect the WORD SYNC OUT of the DA-98 to the WORD CLOCK IN

of the WR-DA7’s master unit (or select the SLOT that has the DA-98 connected to it as the Master

Wordclock source), and connect between the WCK OUT of the master unit for the WR-DA7 to the

WCK IN of the slave unit using the BNC-BNC cables. (Part # DA/BNC: Available in the USA) 

For terminating the wordclock signals, the master unit is selected to 75ohm=OFF (*75 ‘=ON to

obtain synchronization from the slot) and the slave unit is selected to 75 Ohm=ON. 

Connect the WR-TDIF card with DIGITAL I/O (TDIF-1) of the DA-98, 38 using the recommended

cables (Part # WR-TDIF: Available in the USA) and press the DIGITAL IN switch on the front panel

of each DA-98, 38 to select the digital-input mode. 

Make the connections to the DA-98, 38 using the PW-88S SYNC cables, from SYNC OUT to SYNC

IN. Connect a terminator to the SYNC OUT of the last DA-38. 

To make MIDI connections, establish a loop of the two WR-DA7 units and the DA-98, and make

MIDI cable connections from MIDI OUT to MIDI IN. This makes MMC and MTC functions avail-

able. 

(It is possible to receive the SMPTE timecode by using the option card WR-SMPT. Make the connec-

tion from TIME CODE OUT (XLR) of the DA-98 to SMPTE IN (XLR) of the WR-DA7.) 
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WR-DA7 setting 

To use the WR-DA7 as a slave unit, set the SOURCE SELECT to ‘WCK IN’ in the INPUT SET window

of the D-I/O Setup Section on the MASTER unit. 

(For wordclock synchronization using the DA98’s connection slot, set the SOURCE SELECT to

‘SLOT1’ on the MASTER WR-DA7. Keep ‘WCK IN’ on the SLAVE unit.) 

To establish communication between the tandem WR-DA7 units, set the PORT SELECT to ‘TO PC’

in the SERIAL I/O SETUP in the MIDI SETUP screen for both the MASTER and SLAVE units. Then

set the baud rates to the same value. 

To send and receive MIDI messages, set the PORT select of Gen.Rx and Gen.Tx to ‘MIDI’ in the

MIDI SETUP screen. On the TANDEM SLAVE unit, set the SEND/RECEIVE of the various MIDI mes-

sages to ‘THRU.’ 

For MMC set the MMC PORT to ‘MIDI’ in the MIDI SETUP window for the same MMC channels to

be received on the BRC. 

For MTC reception on the WR-DA7, set MTC PORT to ‘MIDI’ in the MIDI SETUP window of the

TANDEM (MASTER) unit. 

To display the MTC timecode, set the TIME BASE to ‘MTC’ in the EXECUTE window of AUTOMA-

TION SETUP Window. 

(To use the SMPTE timecode connect the WR-SMPTE option card, and set the TIME BASE to

‘SMPTE.’ in the EXECUTE window of AUTOMATION SETUP Window.) 

DA-98, 38 setting 

Since the DA-98 and 38 receive digital input data from the TDIF-1, press the DIGITAL IN switch on

the control panel. 

To set the machine ID numbers of the DA-98 and 38, ID: 1 is assigned to the DA-98. The machine

ID numbers are set to 1, 2, 3, and 4 in the order of cable connections from SYNC OUT to SYNC

IN. 

Select the sampling rate of the DA-98 to INT 48k or INT 44.1k. The sampling rate of the DA-98 is

automatically set off the tape that≈ fs being used. 

Operation of the DA-38 is synchronized with the DA-98, as a slave unit for the DA-98. Therefore,

when the ID is set for any value other than 1, the DA-38 is set to the wordclock from the PW-88S

SYNC cable. 

Press the CHASE switch of the DA-38 front panel with the machine IDs 2, 3, and 4 to select CHASE

to ‘ON’ so that synchronization can be performed with the master DA-98. 

While ALL INPUT is ON; no audio is played back. For playback ALL INPUT should be set at OFF. 
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3.6 Example of systems for analog 16-track recorder (1 unit) 

This is an editing system that uses AUTOMATION. The SMPTE timecode is recorded in the 16th

tape track of the analog 16-track recorder and the system works off this timecode. 

Method of connection 

Insert the option card WR-ADDA (Slot 1, 2) and WR-SMPTE in the WR-DA7 and firmly fasten them

to the main body with the supplied screws. 

Connect the IN/OUT terminal using the recommended cable(Part # DA/DB-XLR M-F: Available in

the USA) of the WR-ADDA card of the WR-DA7 to the IN/OUT terminal of the analog 16-track

recorder. 

The timecode is supplied from channel 16 of the analog recorder to the (optional) SMPTE IN

(XLR: 1,3-GND, 2-SIGNAL) of the WR-DA7. 

WR-DA7 setting 

Set the WR-DA7 to the wordclock master. 

In the INPUT SET screen of D-I/O of the WR-DA7, set SOURCE SELECT to ‘INT 48k’ or ‘INT 44.1k.’ 

To display the SMPTE timecode being received at the SMPTE IN, set the TIME BASE to ‘SMPTE’ in

the EXECUTE screen of the AUTOMATION window. 
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System configuration -6
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3.7 Example of systems for Digital Video Recorder (1 unit) 

This is a post-production system consisting of the WR-DA7 and the Digital Video Recorder. The

audio signals are connected using the AES/EBU digital audio option card. The WR-DA7 receives

SMPTE timecode from the Digital Video Recorder for it’s editing and automation operations. 

Method of connection 

Insert the option card of WR-AESS (Slot 1) and the WR-SMPTE (option card) in the WR-DA7 and

fasten them to the console using the supplied screws. Select the switches on the WR-AESS card to

AES/EBU. 

Make the connections to the digital I/O terminals of the WR-DA7 and the Digital Video Recorder

(WR-AESS card: D-sub 25-pin connector, Digital Video Recorder: XLR connector; 

Use the House Video Sync signal to REF IN (BNC) of the Digital Video Recorder, and make the

connection from REF OUT to V-SYNC IN of the WR-DA7. 

The termination of the Digital Video Recorder REF should be set to 75 Ohm=OFF. 

The timecode is transferred from the SMPTE OUT (XLR) of the Digital Video Recorder to the

SMPTE IN (XLR) of the WR-DA7. 

WR-DA7 setting 

Set the SOURCE SELECT to ‘V-SYNC’ in the INPUT SET screen of D-I/O area in order to produce

synchronization with the V-SYNC input. 

To display the SMPTE timecode received at the SMPTE IN, set the TIME BASE to ‘SMPTE’ in the

EXECUTE window of Automation Setup Section

Digital Video Recorder settings: To receive AES/EBU digital audio, make the settings of ‘DIGITAL

IN’ on the LCD screen. 

A ‘CHANNEL STATUS CRCC ERROR’ may be displayed during Digital

recording from the DA7. 

This is; however, a message in regards to the sub-code signal, even

with this being displayed proper audio recording and playback

should be performed. 



33

System configuration -7
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3.8 Example of systems for VTR (1 unit), ADAT (1 unit), and BRC 

This is a post-production system consisting of the ADAT and the BRC, in addition to the WR-DA7

and a video recorder. The SMPTE timecode output is generated from the video recorder, this out-

put goes to the BRC. The BRC supplies the timecode and the wordclock to the ADAT and the WR-

DA7. Editing and Automation becomes possible in synchronization with the timecode from the

video recorder. 

Method of connection 

Insert the option card WR-ADAT in Slot 1 of the WR-DA7 and firmly fasten it to the Da7 with the

supplied screws. 

Connect the WR-ADAT card from the WR-DA7 to the DIGITAL IN/OUT of the ADAT using an optical

cable and press the DIGITAL IN switch on the ADAT’s front panel to select the digital input mode. 

Route the SMPTE timecode from the video recorder to the SMPTE IN (Phone Jack) of the BRC so

that the BRC is synchronized with the timecode of the video recorder. 

To use the BRC as the clockmaster, connect WORD OUT (48kHz) of the BRC to WORD CLOCK IN

of the WR-DA7 using a BNC-BNC cable and set the WR-DA7 termination at 75 Ohm=ON. 

Use MIDI cables to connect the WR-DA7 to MIDI IN/OUT of the BRC. This makes MMC and MTC

functions possible. 

For the timecode, MTC is received from the MIDI connections. It is possible to receive SMPTE

timecode using the WR-SMPT option card (XLR: 1,3-GND, 2-SIGNAL) in the WR-DA7.) 

WR-DA7 setting 

To use the WR-DA7 as a slave unit, set SOURCE SELECT to ‘WCK IN’ in the INPUT SET screen of

the D-I/O. (For synchronization with the ADAT card source, set SOURCE SELECT to ‘SLOT1.’) 

For MMC, set MMC PORT to ‘MIDI’ in the MIDI SETUP screen. The MIDI channel of MMC should

be set to the same MMC channel being received on the BRC. 

To receive MTC on the DA7, set MTC PORT to ‘MIDI’ in the MIDI SETUP screen. 

To view MTC on the DA7’s LCD screen, set TIME BASE to ‘MTC’ in the EXECUTE screen of

AUTOMATION. (To use the SMPTE timecode, set TIME BASE to ‘SMPTE.’) 

ADAT setting 

For ADAT wordclock setting, connect a Sync cable from the BRC and turn on the power supply. At

this time, setting is automatically made to ‘EXT’ and the ADAT works as a slave machine for the

BRC. 

Regarding the power supply for the ADAT and the BRC; the power supply for the ADAT should be

turned on first, then, the power supply for the ADAT should be turned on next. 

The audio input of the ADAT is used in the digital input mode. Therefore, the DIGITAL IN switch

should be selected. 

During ADAT playback, there is no output if ALL INPUT is ON. ALL INPUT must be turned OFF. 
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BRC setting 

To synchronize the BRC with the SMPTE timecode from the video recorder set Locate Reference to

‘SMPTE Input’ and Clock Source to ‘Internal’ by selecting the EXT SYNC setting for the BRC. Then,

turn on the EXT SYNC switch. 

Select the Fixed Mode when the BRC is used as a clockmaster and if the sampling rate is set at

48kHz. Select the Variable Mode when the sampling rate is set at 44.1kHz. Press the PITCH DOWN

switch to setting -147cent ( ‘44.1’ display). 

For MTC setting, select MIDI in the GEN SYNC setting area to ‘MTC’ and turn on the GEN SYNC

switch. 

For SMPTE select SMPTE in the GEN SYNC setting area to ‘-10dB’ and turn on the GEN SYNC

switch. 

To obtain a timecode output from the BRC even during FF/REW operation of the ADAT, set the dis-

play to 8: Output Rew/FF SMPTE & MTC to ‘ON’ in MIDI/UTIL setting of the BRC. 

To accomplish MMC operation, there must be coincidence of the MIDI channel between MMC

output from the WR-DA7 and MMC received on the BRC. On the BRC, set the display to 11: MIDI

Device screen by MIDI/UTIL setting. Set the value of ‘MIDI channel set for the WR-DA7 - 1.’

Otherwise, setting should be made to ‘ALL.’ 

A ‘CHANNEL STATUS CRCC ERROR’ may be displayed during Digital

recording from the DA7. 

This is; however, a message in regards to the sub-code signal, even

with this being displayed proper audio recording and playback

should be performed. 
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System configuration -8
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3.9 Example of systems for VTR (1 unit) and DA-98 (1 unit) 

This is a post-production system consisting of the DA-98, one WR-DA7 and a video recorder. The

SMPTE timecode output is generated from the video recorder and is supplying timecode to the

DA-98. Receiving the SMPTE timecode, the DA-98 supplies the timecode and the wordclock to the

WR-DA7. In this mode, editing operation becomes possible by the use of the AUTOMATION feature

in synchronization with the timecode of the video recorder. In this system, House Video Sync is

used as the wordclock master. 

Method of connection 

With the DA7 powered off, insert the option card WR-TDIF in Slot 1 of the WR-DA7 and firmly fas-

ten it to the mixer with the supplied screws. Make the setting for the DA-88 with the dip switches

on the WR-TDIF card (SW1, 2 to OFF, respectively). 

Connect the WR-TDIF card from the WR-DA7 to the DIGITAL I/O (TDIF-1) of the DA-98 and press

the DIGITAL IN switch of the DA-98 front panel to select the digital input mode. 

Connect House Video Sync to VIDEO IN (BNC) of the video recorder and the DA-98. 

Connect the WR-DA7 to the MIDI IN/OUT of the DA-98 using a MIDI cable to use the MMC and

MTC functions. 

For timecode, MTC is received from the MIDI connection. (Using the option card WR-SMPT, it is

also possible to receive the SMPTE timecode. In this case, the TIME CODE OUT (XLR) of the DA-

98 is connected to the SMPTE IN (XLR) of the WR-DA7.) 

When using the DA-88 in place of the DA-98, connect WORD SYNC OUT of the DA-88 to WORD

CLOCK IN of the WR-DA7 using a BNC cable and set the WR-DA7 wordclock termination to 75

Ohm=ON. 

WR-DA7 setting 

The DA-88 functions as the wordclock master and the WR-DA7 as a slave unit. Set the SOURCE

SELECT to ‘WCK IN’ in the INPUT SET screen of the D-I/O of the WR-DA7. (For DA-98, 38 connec-

tions, synchronization with the SLOT and V-SYNC is also possible.) 

To set the MIDI channel for MMC, set MMC PORT to ‘MIDI’ in the MIDI SETUP screen and select

the MIDI channel setting. 

To receive MTC timecode, set MTC PORT to ‘MIDI’ in the MIDI SETUP screen. 

To display MTC on the DA7’s LCD screen, set TIME BASE to ‘MTC’ in the EXECUTE screen of

AUTOMATION. 

(To use the SMPTE timecode set TIME BASE to ‘SMPTE.’) 

DA-98 setting 

Operation of the DA-98 is synchronized with the SMPTE timecode being generated from the video

recorder. 

To enable DA-98 operation synchronized with the SMPTE timecode, press the CHASE switch on

the front panel and set CHASE to ‘ON.’ 

Set the machine ID number of the DA-98 to 1. (ID=0 for the DA-88) 
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To enable the DA-98 to receive digital input from the TDIF-1, press the DIGITAL IN button on the

front panel. 

When the timecode output of the video recorder is generated after being converted to MTC, the

MODE dip switch 6 on the SY-88 rear side is set to OFF. (If this switch is set to ON, the timecode

recorded on the tape is converted into MTC and the resultant output is generated.) 

Use the tape where the recorded timecode has the same frame rate as that of the SMPTE timecode

output generated from the video. It is impossible to perform operation synchronized with the

SMPTE timecode of the video recorder if no timecode is recorded in the tape or there is failure in

coincidence of the frame rate. 

Turn on the CHASE switch of the DA-98. 

Set the dipswitch 8 at ON the SY-88 board. 

While ALL INPUT is ON; no playback is generated. To realize playback, ALL INPUT should be set to

OFF. 

A ‘CHANNEL STATUS CRCC ERROR’ may be displayed during Digital

recording from the DA7. 

This is; however, a message in regards to the sub-code signal, even

with this being displayed proper audio recording and playback

should be performed. 
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System configuration-9
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3.10  System Example of Pro Tools

This example illustrates using the WR-DA7 in a Pro Tools system.  Editing can be performed using

Automation, etc. after synchronizing Pro Tools with the WR-DA7 in reference to the timecode from

an ADAT (BRC).  It then becomes possible to control Pro Tools, ADAT and BRC from the WR-DA7

using MMC, or to control the various parameters of Pro Tools from the WR-DA7 using the MIDI

remote function of the WR-DA7.

Connecting Procedures

With the WR-DA7 powered "OFF" (Set the switches on the WR-AESS card to the AES/EBU position)

insert the option cards WR-AESS (slot 1), WR-ADAT (slots 2 and 3), and WR-SMPTE into the WR-

DA7, fasten them securely with the supplied screws to ensure proper grounding.

Connect the digital I/O connectors from the WR-DA7 and 888 I/O (D-sub 24-pin connector on the

WR-AESS card, XLR connector on the 888 I/O. (See the Digidesign's website for the proper cable

specifications.)

Connect the Macintosh computer to the MIDI interface (MIDI Timepiece A/V  A/V) using the

modem port.

Connect the WR-ADAT cards from the WR-DA7 to the DIGITAL IN/OUT of an ADAT using an optical

cable, and press the [DIGITAL IN] switch on the front panel of each ADAT to select the digital

input mode.

The BRC functions as the wordclock master.  Connect WORD OUT on the BRC to WORD CLOCK

IN on the WR-DA7 with a BNC cable, and terminate the WR-DA7 at 75 ohms (=ON).

Connect the WR-DA7 to port 1 MIDI IN/OUT of MIDI Timepiece A/V using a MIDI cable.  The MMC

and MTC functions can be used.

using a standard MIDI cable, connect the MIDI IN on the BRC to port 2 MIDI OUT of the MIDI

Timepiece A/V to control the ADAT with MMC.  Then connect the MIDI OUT on the BRC to port 2

MIDI IN of MIDI Timepiece A/V using a MIDI cable to operate the WR-DA7 and Pro Tools in refer-

ence to the BRC's timecode.

To set MIDI connection with the WR-DA7 and MIDI Timepiece A/V using OMS start the [OMS MIDI

Setup] in the Setup menu of Pro Tools and execute the simplified setup.  Make sure that the MIDI

Timepiece A/V, the WR-DA7 and BRC have been switched on.

1. Check the device connected to Port 1 of the MIDI Timepiece A/V on the OMS MIDI device

setup screen that is displayed after the simplified setup.

2. Then, to set the MIDI messages to be used by the WR-DA7, start [OMS Studio Setup] on the

Setup menu, and set [Manuf] to [Other], [Model] to [Other], and [Name] to [WR-DA7] on the

Setup screen.

3. Enter a check mark at [Receives] for MIDI Timecode and [Sends] for MIDI Machine Control

in order to use the MTC and MMC and also at [1] for Receive Channels to select channel 1 for

MIDI reception.

Set [In 1 > Out 2 Y] and [In 2 > Out 1 Y] in the MIDI Routing window of MIDI Timepiece A/V  to

select the MIDI cable routing.

WR-DA7 Setup

Set the [Source Select] to [WCK IN] in the Input Set screen of D-I/O to set the WR-DA7 as slave.

To receive MTC timecode, set [MTC Port] to [MIDI} in the MIDI Setup screen.
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To display MTC timecode on the LCD screen set the [Time Base] to [MTC] in the Automation

Execute screen of the WR-DA7.

To use MMC set the [MMC Port] to [MIDI] in the MIDI Setup screen.

To control the various parameters of Pro Tools using the MIDI remote function of the WR-DA7, Pro

Tools exchanges messages on MIDI channel 16.  It is necessary, to take the following steps.

1. Set [Remote 1 Port] to [MIDI] and [CH] to [16] in the MIDI Setup screen.  (The same settings

as in Remote 1 are necessary for using Remote 2.)

2. To allocate MIDI Remote to the custom fader layers, set [MIDI Remote Switches No. 1 - No. 8]

to [ON] on the User CSTM screen so that MIDI CH 16 will be shown as the assigned channel.

(In the case of using Remote 2, set [MIDI Remote Switches No. 9 to No. 16] to [ON] so that

MIDI CH 16 will be shown as the assigned channel.)

3. To set the CTRL CHG numbers of Pro Tools to the SOLO switch, ON switch, PAN knob, and

faders of the custom fader layer, select [Fader Select 1-8] in the MIDI RMT screen and set

[Mode Edit] to [ON].  (Select [Fader Select 1-9] for using Remote 2.)

Then, set CTRL CHG numbers of Pro Tools in decimals on the MIDI Remote Edit screens for the

SOLO switch, ON switch, PAN knob, and faders.

Pro Tools Setup

To make the 888 I/O of Pro Tools the Wordclock slave, set the [Sync Mode] to [Digital] in the Show

Session Setup Window in the Display menu.

To receive digital inputs set [Ch 1-2 Input] to [Digital] in the Show Session Setup Window of the

Display menu.

To match the frame rates of the timecode being received select [Frame Rate] in the Show Session

Setup Window of the Display menu.

To record and playback with Pro Tools synchronized with the BRC's timecode, select [Online] in

the Option menu to set Pro Tools to online.

To control the various parameters of Pro Tools using the MIDI remote function of the WR-DA7,

select Type [CS-10] for the MIDI controllers in the Peripherals area in the Setup menu, then pro-

ceed to [Receive From] to select the device name [WR-DA7] given in the OMS Studio Setup

process.  (If no device has been set yet, select [Port 1] is shown.)

ADAT, BRC Setup

With the BRC serving as the wordclock master, select [Fixed Mode] to set a sampling rate of 48

kHz, or select [Variable Mode] to set a sampling rate of 44.1 kHz.  Then press the [Pitch Down]

switch to set -147 cent ([44.1] shown on the screen).

In the SMPTE setup, set SMPTE to [-10 dB] in the Gen Sync setup menu, and press the [Gen Sync]

switch to "On".

To output timecode from the BRC during FF/REW, set item 8 [Output Rew/FF SMPTE & MTC] on

the BRC's MIDI/UTIL setup menu to [ON].

To operate MMC, the MMC MIDI channels of the WR-DA7 and BRC must be set the same.  On the

BRC, set item 11 [MIDI Device] on the MIDI/UTIL setup menu to "(the MIDI channel set by the

WR-DA7) minus 1" or [ALL].
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System Configuration-10
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3.11  System Example of MIDI Sequencer (Performer)

This example illustrates the WR-DA7 mixing automation system using MIDI sequencer software

(Performer) in a personal computer.  By using a MIDI sequencer, the WR-DA7's Faders, EQ, PAN,

and channel ON/OFF can be controlled in synchronization with the sequencer.  WR-DA7 operation

data can be sent to a MIDI sequencer to be stored and recalled.  It is also possible to control the

sequencer software, the BRC and the ADAT's from the WR-DA7 using the WR-DA7's MMC functions.

Connecting Procedures

With the WR-DA7 powered "OFF" insert the option cards WR-ADAT into the WR-DA7 slots 1, 2, 3,

and fasten them securely with the supplied screws to insure proper grounding.

Connect the modem port of the MIDI sequencer (Macintosh computer) to the Mac port of the

MIDI interface (MIDI Timepiece A/V) using a serial cable.

Connect the WR-ADAT cards of the WR-DA7 to the DIGITAL IN/OUT of ADAT using an optical cable,

then press the [DIGITAL IN] switch on the front panel of each ADAT to select the digital input

mode.

The BRC functions as the wordclock master.  Connect the WORD OUT of the BRC to the WORD

CLOCK IN of the WR-DA7 using a 75 ohm BNC-BNC cable, and terminate the WR-DA7 to 75 ohms

(=ON).

Connect the WR-DA7 to port 1 MIDI IN/OUT of the MIDI Timepiece A/V using standard MIDI

cables.  The MMC and MTC functions are now possible.

Connect the MIDI IN on the BRC to port 2 MIDI OUT of the MIDI Timepiece A/V using a Standard

MIDI cable to control the ADAT using MMC.  Then connect the MIDI OUT of the BRC to port 2

MIDI IN of the MIDI Timepiece A/V with a MIDI cable to operate the WR-DA7 and Pro Tools in ref-

erence to the BRC's timecode.

To set the MIDI connections with the WR-DA7 and the MIDI Timepiece A/V using Free MIDI, start

[Create Device]in the Configuration menu of the Free MIDI Setup and connect the WR-DA7.

In the Free MIDI Device Specification screen, enter [WR-DA7] in the [Name] line, and set

[Manufacturer] to [Other] and [Model] to [Other].  To select channels to send and receive MIDI

messages, enter a check mark at [1] on the [Transmit Channels] and [Receive Channel] respective-

ly; select [MTP AV, Modem] for [Studio Location] to set the connection port with the MIDI

Timepiece A/V , and set [Cable] to [1].

WR-DA7 Setup

Set the [Source Select] to [WCK IN] in the Input Set screen of D-I/O to set the WR-DA7 as the

Wordclock slave.

To receive MTC timecode, set [MTC Port] to [MIDI} in the MIDI Setup screen.

To display MTC timecode on the LCD screen set the [Time Base] to [MTC] in the Automation

Execute screen of the WR-DA7.

To use MMC set [MMC Port] to [MIDI] in the MIDI Setup screen.

To set the ports and MIDI channels to be used for MIDI, set [Gen Rx, Gen TX] ports to [MIDI] and

[CH] to [1] in the D-I/O setup screen of the WR-DA7.

To use Program Change set [Tx, Rx] to [ON] in the MIDI setup area of the MIDI Setup Window.
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To use Control Change, set [Tx, Rx] and NRPN to [ON] in the CTRL CHG setup area of the MIDI

Setup Window.

To use System Exclusive set [Tx, Rx] to [ON] in the System EX setup area of the MIDI setup

Window.

MIDI Sequencer (Performer) Setup

To operate Performer in synchronization with the timecode of the BRC, select [Modem] with

[Receive Sync] and [MTO, DTL, or DTLe] with the [Type of Sync] in the Basic menu of Performer.

Then select the frame-rate with the [SMPTE Frame Format] to match the frame-rate of the time-

code that’s being received.

To record WR-DA7 operation on the MIDI sequencer (Performer), start [Patch Thru] in the Basic

menu and set [Select Patch Thru Mode] to [OFF] so the MIDI sequencer will not echo MIDI mes-

sages.

To set Performer to slave mode, select [Slave to External Sync] in the Basic menu.  Then, select

[Control Panel] in the Windows menu of Performer, then press the [PLAY] and [REC] buttons in

the open window so Performer will stand by to receive timecode.

ADAT, BRC Setup

With the BRC serving as the wordclock master, select [Fixed Mode] to select a sampling rate of 48

kHz, or select [Variable Mode] to select a sampling rate of 44.1 kHz.  Then press the [Pitch Down]

switch to set -147 cent ([44.1] shown on the screen).

MTC setup, set MIDI to [MTC] in the Gen Sync setup menu, and press the [Gen Sync] switch to

[ON].

To output timecode from the BRC during ADAT FF/REW, set item 8 [Output Rew/FF SMPTE &

MTC] on the BRC MIDI/UTIL setup menu to [ON].

To operate the MMC, the MMC and MIDI channels of the WR-DA7 and BRC must be set the same.

On the BRC, set items 11 [MIDI Device] on the MIDI/UTIL setup menu to "the MIDI channel set by

the WR-DA7 minus 1" or [ALL].
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3.12  System Example of WR-DA7 Tandem-Connection to a MIDI Sequencer 
(Performer)

This example refers to the configuration a mixing automation system using two WR-DA7s and a

MIDI sequencer (Performer) in a personal computer.  By using the MIDI sequencer, the Faders,

EQ, PAN, and channel ON/OFF of the two WR-DA7s can be controlled separately in synchroniza-

tion using MIDI timecode.  The setup data of the two WR-DA7s can be sent to the MIDI sequencer

to be stored and later recalled.  It is also possible to control Performer, the BRC and ADAT's using

the MMC functions.

Connecting Procedures

With the WR-DA7 powered "OFF". Insert the WR-TNDM cards into slot 3 of each of the WR-DA7s,

and fasten them securely using the supplied screws.

Set the switch on the back of the WR-TNDM card of the master WR-DA7 to [Master] and set the

same switch on the slave WR-DA7 to [Slave].

Connect the WR-TNDM cards in the WR-DA7s together using the specified Tandem Cable.  (Refer

to the owner's guide for cable specifications.)

Connect the [To PC Port] of the master WR-DA7 to the slave WR-DA7 using the specified To-PC

cable for communications between the two WR-DA7s.

BRC functions as the wordclock master.  Connect the 48kHz WORD OUT of the BRC to the WORD

CLOCK IN on the WR-DA7s using a 75 Ohm BNC-BNC cable, terminate the slave WR-DA7

Wordclock at 75 ohms (=ON).

Connect using the modem port of the MIDI sequencer (Macintosh computer) to the Mac port of

the MIDI interface (MIDI Timepiece A/V ) using a serial cable.

Connect the MIDI IN/OUT of the master WR-DA7 to port 1 IN/OUT of the MIDI Timepiece A/V .

Connect the MIDI IN/OUT of the slave WR-DA7 to port 2 IN/OUT of MIDI Timepiece A/V .

Connect the MIDI IN of the BRC to port 3 MIDI OUT of the MIDI Timepiece A/V  using a MIDI

cable to control the ADAT's with MMC.  Also connect MIDI OUT on the BRC to port 3 MIDI IN of

MIDI Timepiece A/V  using a cable to operate the WR-DA7s and Performer in reference to the BRC

timecode.

To select the MIDI connections with the WR-DA7s and MIDI Timepiece A/V  using Free MIDI, start

[Create Device] in the Configuration menu of the Free MIDI Setup and connect the WR-DA7s.

On the Free MIDI Device Specification screen, enter [WR-DA7 (Master)] in the [Name] line,

and set [Manufacturer] to [Other] and [Model] to [Other].  To set channels to send and

receive MIDI messages, enter a check mark on [1] on the  [Transmit Channels] and [Receive

Channels] lines, respectively; select the [MTP AV, Modem] for [Studio Location] to set the con-

nection port with the MIDI Timepiece A/V , and set [Cable] to [1].

In the Free MIDI Device Specification screen, similarly enter [WR-DA7 (Slave)] in the [Name]

line, and set [Manufacturer] to [Other] and [Model] to [Other].  To select the channels to

send and receive MIDI messages, enter a check mark on [1] in the  [Transmit Channels] and

[Receive Channels] lines, respectively; select the [MTP AV, Modem] for [Studio Location] to

set the connection port with the MIDI Timepiece A/V , and set [Cable] to [2].
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WR-DA7 Setup

To set the WR-DA7 tandem master and slave as the WCK (wordclock) slave, set the [Source Select]

to [WCK IN] in the D-I/O Input Set screen of the WR-DA7.

To set the MIDI input and output ports, set [Gen Rx, Gen Tx] ports to [MIDI] and the [CH] of

both of the WR-DA7s to [1] in the MIDI setup screen.

To use Program Change set [Tx, Rx] to [ON] in the PRG CHG setup area in the MIDI setup screen.

To use Control Change, set [Tx, Rx] and NRPN to [ON] in the CTRL CHG setup area in the MIDI

setup screen.

To use System Exclusive set [Tx, Rx] to [ON] in the System EX setup area in the MIDI setup screen.

To have the WR-DA7 receive MTC, set the [MTC Port] to [MIDI] in the MIDI Set up area of the

MIDI setup screen for the tandem master WR-DA7.

To display MTC timecode on the LCD screen set the [Time Base] to [MTC] in the Automation

Execute screen.

To use MMC set [MMC Port] to [MIDI] in the MIDI setup area of the Tandem master WR-DA7.

To establish communication between the two WR-DA7s, set the [Port Select] to [To PC] in the serial

I/O setup item of the MIDI setup Area on both the master and slave, and select the same baud rate

(125K) for both.

To make the tandem connection valid select [Tandem] to [ON] in the D-I/O [To Slot] screen. Make

sure the PORT SELECT is set TO PC, then select AUTO in the OFFSET DELAY SECTION. CONNECT

will read SLOT NG or DATA NG until the SLAVE console is configured.
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MIDI Sequencer (Performer) Setup

To record WR-DA7 operation in the MIDI sequencer (Performer), start [Patch THRU] on the Basic

menu and set [Select Patch THRU Mode] to [OFF] so that the MIDI sequencer does not echo MIDI

messages.

To record the operations of both the WR-DA7 master and slave on the MIDI sequencer

(Performer), select [Multi Record] on the mini-menu of the track screen of the MIDI sequencer.

Then set the two track into record mode on the track screen, and set each [Input] to [WR-DA7

(Master)] and [WR-DA7 (Slave)].

With Performer, a MIDI message to each MIDI Timepiece A/V  input port

could be recorded on separate tracks.  To simultaneously record and

playback the MIDI messages of both the master WR-DA7 and slave WR-

DA7 with a MIDI sequencer having only one track, it is necessary to

select different MIDI channels within the MTP for the master and slave

WR-DA7s to be outputted to the MIDI sequencer.  For this purpose,

start [MTP/Express Console] of the MIDI Timepiece A/V  and set the

Channel Map screen as follows:

After it is set, record the master and slave WR-DA7s with the MIDI

sequencer.

WR-DA7 (Master):

(From)  Map Channel 1 to 2

(To)  Map Channel 2 to 1

WR-DA7 (Slave):

(From)  Map Channel 1 to 3

(To)  Map Channel 3 to 1

ADAT, BRC Setup

With the BRC serving as the wordclock master, select the [Fixed Mode] to set a sampling rate of 48

kHz, or select [Variable Mode] to set a sampling rate of 44.1 kHz.  Then press the [Pitch Down]

switch to set -147 cent ([44.1] shown on the screen).

In the MTC setup, set MIDI to [MTC] on the Gen Sync setup menu, and press the [Gen Sync]

switch on.

To output timecode from the BRC during ADAT FF/REW, set item 8 [Output Rew/FF SMPTE &

MTC] on the BRC MIDI/UTIL setup menu to [ON].

To operate the MMC, the MMC MIDI channels of the WR-DA7s and BRC must be the same.  On the

BRC, set items 11 [MIDI Device] on the MIDI/UTIL setup menu to "the MIDI channels set by the

WR-DA7s minus 1" or [ALL].
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3.13  System Example of AKAI DR8 (1 unit)

This example refers to a system consisting of an Akai DR8 hard disk recorder and a WR-DA7 con-

nected using an optical cable and the ADAT interface board to process the 8-track data between

them.  The MIDI interface board may be used for transport operation of the DR8 synchronized

with MTC timecode, and the DR8 can be controlled using MMC.

Connecting Procedures

With The WR-DA7 powered "OFF" Insert the option card WR-ADAT (slot 1) into the WR-DA7, and

fasten it securely using the supplied the screws.

Connect the WR-DA7 to DIGITAL IN/OUT of the DR8's ADAT card using an optical cable.

Insert the option cards IB-804A into the DR8.  Install the option card IB-803M to use MTV, or the

option IB-802T to use SMPTE timecode.

Connect the WR-DA7 to DIGITAL IN/OUT of the DR8's ADAT card using an optical cable.

Use a MIDI cable to connect the WR-DA7 to MIDI IN/OUT of DR8.  This makes it the MMC and

MTC functions operational.

WR-DA7 Setup

Set the [Source Select] to [Slot 1] on the Input Set screen of D-I/O to set the WR-DA7 as the word-

clock slave.

To use MMC set the [MMC Port] to [MIDI] in the MIDI Setup screen.

to receive MTC on the WR-DA7, set the [MTC Port] to [MIDI} in the MIDI Setup screen.

To display MTC timecode on the LCD screen, set the [Time Base] to [MTC] in the Automation

Execute screen.

(To connect the WR-SMPTE card and use SMPTE timecode, set the [Time Base] to [SMPTE].)

DR8 Setup

xthe DR8 serves as the wordclock master, press the [Sub-Menu] key and the numeral 2 key (DIGI),

then select [XTAL] with DIGI SYNC.

To select a sampling frequency, press the [Sub-Menu] key and the numeral 2 key (DIGI), then

select 44.1 kHz or 48 kHz with SMPL RATE.

To use ADAT digital inputs, press the [Sub-Menu] key and [DIGI] (DIN) key, then select ADAT.

Then, press the [DIGI] key to make digital inputs valid.

To set MTC, press the [Sub-Menu] key and [Sync] key, then select [Master] with MIDI-MTC and

select the type of timecode to be outputted.  Then, press the [Sync] key to make timecode output

valid.

To use SMPTE timecode using the option card IB-802T, press the [Sub-Menu] key and [Sync] key,

select [Master] with SMPTE-LTC and the type of output timecode.  Then, press the [Sync] key to

make timecode output valid.

To set MMC press the [Sub-Menu] key and [Sync] key, then select [Slave] with MIDI-MMC.
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3.14  Connection to MAX (Macintosh) expansion software

The example refers to the building of a recording and mixing automation system using one WR-

DA7 and the expansion software of a personal computer.  By using the expansion software, the

faders, EQ, PAN, and channel ON/OFF of the WR-DA7 can be separately controlled in synchroniza-

tion with the MIDI timecode.  The setup data of the WR-DA7 can be uploaded to and downloaded

from the expansion software.

Connecting Procedures

Connect the modem port of the Macintosh computer to the [To PC] port of the WR-DA7 using a

Macintosh serial cross cable (ImageWriter printer cable).

For the MMC control of the DA-98 serving as the timecode master from the WR-DA7, connect the

MIDI OUT of the WR-DA7 to the MIDI IN of the DA-98 and MIDI IN of the WR-DA7 to MIDI OUT of

the DA-98 using standard MIDI cables.

This system uses the DA-98 as the wordclock master and synchronizes the WR-DA7 with the WR-

TDIF card, therefore no word clock connection is necessary

WR-DA7 Setup

This system uses the DA-98 as word clock master.  The WR-DA7 is synchronized with the DA-98

that is connected to Slot 1.  So, set [Source Select] to [Slot 1] on the D-I/O input set screen.

To receive MTC from the DA-98 and make the expansion software through, set [MTC Port] to

[MIDI] and [THRU] in the item [Others] to [ON].  Since the MMC is being transmitted from the

WR-DA7 to the DA-98, set the [MMC Port] to [MIDI] and match [MIDI CH] with the MIDI/bus ID of

the DA-98.

PC (Macintosh) Setup

If Free MIDI is installed, there is a possibility of a conflict.  It is recommended that it be removed

using the computer's extension manager.

Expansion Software Setup

Select [Preference] from the Edit menu and open the dialog.  Select [Port Setup] in the dialog, and

set the [Automation Port] to [Modem].

Similarly, select WR-DA7 Timecode Input as Sync Source in the Preference Port Setup menu.  Then,

check [Receive Timecode] on the Real-time menu.  It is now ready to receive MTC from the DA-98

via the WR-DA7.
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3.15  Connection to MAX (Macintosh) expansion software and 
Other Sequence Software

This example illustrates a recording and mixing automation system using one WR-DA7, PC expan-

sion software, and sequencing software such as Digital Performer.  The combined use of the

expansion software and Digital Performer makes it possible to control the WR-DA7 and MIDI

devices in synchronization with MIDI timecode.

Connecting Procedures

Connect the printer port of the Macintosh computer to the [To PC] port of the WR-DA7 and the

modem port of the Macintosh computer to the Mac port of MIDI Timepiece A/V using Macintosh

serial cross cables (printer cables).  Remember that the MIDI Timepiece A/V  computer button

must be up in the Mac position (not pressed).

To send timecode to the Macintosh computer with the DA-98 serving as timecode master, connect

MIDI OUT of the DA-98 to Port 4 IN of MIDI Timepiece A/V  and Port 3 OUT of MIDI Timepiece

A/V  to MIDI IN of the WR-DA7 using standard MIDI cables.

For MMC control of the DA-98 from the WR-DA7, connect the MIDI OUT of the WR-DA7 to the

MIDI IN of the DA-98 using a MIDI cable.

This system uses the DA-98 as the wordclock master and synchronizes the WR-DA7 with the WR-

TDIF card, therefore no word clock connection is necessary.

For communication from the MIDI sequencer to the MIDI sampler and MIDI keyboard, connect

the MIDI Timepiece A/V  to each MIDI device using a MIDI cable.

WR-DA7 Setup

This system uses the DA-98 as word clock master.  The WR-DA7 is synchronized with the DA-98

that is connected to Slot 1.  So, set [Source Select] to [Slot 1] on the D-I/O input set screen.

To receive MTC from the DA-98 and make the expansion software through, set [MTC Port] to

[MIDI] and [Thru] in the item [Others] to [ON].  As MMC is transmitted from the WR-DA7 to the

DA-98, set [MMC Port] to [MIDI] and match [MIDI CH] with the MIDI/bus ID of the DA-98.

MIDI Timepiece A/V Setup

To send the MTC received from the DA-98 to the WR-DA7, establish a connection from Port 4 IN to

Port 3 OUT.

To send the MTC received from the DA-98 to the Macintosh (for the MIDI sequencer), establish a

connection from Port 4 IN to the computer.

To connect the Macintosh computer (for the MIDI sequencer) to the MIDI devices, establish con-

nections from Port 1 and Port 2 IN and OUT to the computer.
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Macintosh Setup

To have the Macintosh recognize the MIDI Timepiece A/V and various MIDI devices using Free

MIDI.

Open Free MIDI Preferences in the File menu, then select only the “Modem” check box of MIDI

Configurations, Serial Ports. We recommend you to leave the other check box blank for “Printer",

avoiding possible conflicts in serial communications.

If OMS is installed, there is a possibility of conflict.  It is recommended that it be disabled using

the computer's extension manager.

Expansion Software Setup

Select [Preference] from the Edit menu and open the dialog box.  Select [Port Setup] in the dialog

box and set the [Automation Port] to [Printer].

Similarly, check that [Use MIDI] has no check mark in the preference port setup menu.  If it has a

check mark, de-select it and restart the expansion software.

Similarly, select [WR-DA7 Timecode Input] as a sync source on the preference port setup menu.

Then, select a check mark for [Receive Timecode] on the Real-time menu so that MTC can be

received from the DA-98 via the WR-DA7.

MIDI Sequencer (Digital Performer) Setup

To receive MTC from the DA-98 through the MIDI Timepiece A/V , set Sync Port to [Modem] on

the Receive Sync item of the Basic menu, and set [Type of Sync] to [MTC, DTL or DTLe].  Then,

set [Slave to External Sync] to [ON] in the Basic menu and press the [Play] button on the control

panel.  When MTC is received from the MIDI Timepiece A/V , Digital Performer timecode begins to

run.
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3.16 Tandem-Connection to MAX (Macintosh) expansion software

The example refers to a recording or mixing automation system using two WR-DA7s and PC expan-

sion software.  By using the expansion software, the faders, EQ, PAN, and channel ON/OFF of the

two WR-DA7s can be separately controlled in synchronization with the MIDI timecode.  The setup

data of the two WR-DA7s can be stored and later recalled from the expansion software.

Connecting Procedures

You will need two serial cross cables (ImageWriter II printer cables) ready, and connect the printer

port of the Macintosh computer (for the expansion software) to the [To PC] port of the master and

the modem port of the computer to the [To PC] port of the slave.

With the WR-DA7 powered "OFF" Insert the WR-TNDM card into slot 3 of each of the two WR-DA7s,

and fasten the cards securely with the supplied screws.

Set the switch on the back of the WR-TNDM card in the master WR-DA7 of the tandem system to

[Master] and select slave on the WR-DA7 to act as the [Slave].

Connect the WR-TNDM cards in the two WR-DA7s to each other using the proprietary Tandem

cable (Part # DA/DB available in the U.S.A.).

Connect the MIDI port of the master WR-DA7 to Port 1 of MIDI Timepiece A/V  and the MIDI port

of the slave WR-DA7 to Port 2 of MIDI Timepiece A/V using standard MIDI cables for communica-

tion between the two WR-DA7s.

For connection of the two WR-DA7s to the DA-98 and DA-38s refer to the example of the system

that uses the TASCAM MDM's.

For word clock connection, connect WCK OUT of the master WR-DA7 to WCK IN of the slave WR-

DA7 using a 75-ohm BNC-BNC cable.  Set the termination of the master and slave WR-DA7s to 75

ohms (=ON), respectively.

To make the DA-98 serve as timecode master, connect the MIDI OUT of the DA-98 to Port 3 IN of

the MIDI Timepiece A/V using a MIDI cable.

To supply MMC from the master to the DA-98, connect the MIDI IN of the DA-98 to Port 3 of MIDI

Timepiece A/V using a MIDI cable.

To sync the operation of the three DA-38s with the DA-98, connect the Sync Out of the DA-98 to

the Sync In of the first DA-38 using a TASCAM sync cable (PW-88S or L).  Similarly, connect the sec-

ond and third DA-38s.

WR-DA7 Setup

This system uses the DA-98 as the wordclock master.  The WR-DA7 is synchronized with the DA-98

that is connected to Slot 1.  Therefore, set [Source Select] to [Slot 1] on the D-I/O input set

screen.

This system uses the DA-98 as the timecode master.  Set the MTC receive ports of the two WR-DA7s

to MIDI.  Set [Thru] in the [Others] item to [ON] because MTC through the expansion software is

necessary for the master.

This system performs MMC control on the DA-98 from the master, set the MMC Port of the master

to MIDI and [Thru] in the item [Others] to [ON] and match [MIDI CH] with the MIDI/bus ID of

the DA-98.
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MIDI Timepiece A/V Setup

For tandem communication between the two WR-DA7s, establish connections from Port 1 OUT to

Port 2 IN and from Port 2 OUT to Port 1 IN.

To have the two WR-DA7s receive MTC from the DA-98, establish connections from Port 3 OUT to

Port 1 IN and to Port 2 IN.

For MMC control of the DA-98 by the master, establish a connection from Port 1 OUT to Port 3 IN.

Macintosh (for Expansion Software) Setup

The serial ports cannot be used for OMS and FREE MIDI.  It is recommended, therefore, that they

be disabled using the computer's extension manager.

Expansion Software Setup

Select [Preference] from the Edit menu and open the dialog box.

Select [General], then set [Number of Console] to [2].

Select [Port Setup], then both [Modem] and [Printer] in the Automation Port area.  Also set [Sync

Source] to [WR-DA7 Timecode Input].

When [OK] is pressed in the [Preference] dialog, the expansion software loads the setup data from

the master and slave.

To receive timecode set the [Sync Source] to [WR-DA7 Timecode Input] in the Preference Port

Setup area of the Edit menu.  Then, enter a check mark at the [Receive Timecode] in the Real-time

menu.
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System Configuration-16
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3.17   Tandem-Connection to MAX (Macintosh) expansion software and 
Other Sequencing Software

This example refers to the building of a recording or mixing automation system using two WR-

DA7s, PC expansion software, and other sequence software such as Digital Performer.  Combined

use of the expansion software and Digital Performer makes it possible to control the two WR-DA7s

and MIDI devices, in which a MIDI sound source, etc. are installed, in synchronization with MIDI

timecode.

Connecting Procedures

You'll need two Macintosh serial cross cables (ImageWriter printer cables) ready, and connect the

printer port of the Macintosh computer (for expansion software) to the [To PC] port of the master

and the modem port of the computer to the [To PC] port of the slave.

Insert the WR-TNDM card into slot 3 of each of the two WR-DA7s, and fasten the cards securely

with the screws.

Set the switch on the back of the WR-TNDM card in the master WR-DA7 of the tandem system to

[Master] and the same switch on the same card in the slave WR-DA7 to [Slave].

Connect the WR-TNDM cards in the two WR-DA7s to each other with a D-sub 25-pin cable specially

made for tandem connection.  (Refer to the home page for cable specifications.)

Connect the MIDI port of the master WR-DA7 to Port 1 of MIDI Timepiece A/V  and the MIDI port

of the slave WR-DA7 to Port 2 of MIDI Timepiece A/V with MIDI cables for communication between

the two WR-DA7s.

For connection of the two WR-DA7s to the DA-98 and DA-38s refer to the example of the system

that uses TASCAM MTR.

For word clock connection, connect WCK OUT of the master WR-DA7 to WCK IN of the slave WR-

DA7 with a BNC cable.  Set the termination of the master and slave WR-DA7s to 75 ohms (=ON),

respectively.

To make the DA-98 serve as timecode master, connect MIDI OUT of the DA-98 to Port 3 IN of MIDI

Timepiece A/V with a MIDI cable.

To supply MMC from the master to the DA-98, connect MIDI IN of the DA-98 to Port 3 OUT of

MIDI Timepiece A/V with a MIDI cable.

To synchronize the operation of the three DA-38s with the DA-98, connect the Sync Out of the DA-

98 to Sync In of the first DA-38 with a TASCAM sync cable (PW-88S or L).  Similarly, connect the

second and the third DA-38’s.

To connect the MIDI sequence to two MIDI devices via the MIDI Timepiece A/V, connect the

Modem port of the Macintosh computer, in which Performer is installed, to the Mac port of the

MIDI Timepiece A/V  with a printer cable.

Connect the MIDI keyboard to Port 4 of MIDI Timepiece A/V and the MIDI sampler to Port 5,

respectively, with MIDI cables.
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WR-DA7 Setup

This system uses the DA-98 as word clock master.  Since the DA-98 is connected to Slot 1 of the

master, set [Source Select] to [Slot 1] on the D-I/O input set screen, and set the slave to WCK IN.

This system uses the DA-98 as timecode master.  Set the MTC receive ports of the two WR-DA7s to

MIDI.  Set [Thru] in the [Others] item to [ON] because MTC through the expansion software is

necessary for the master.

This system performs MMC control on the DA-98 from the master, set the MMC Port of the master

to MIDI and match [MIDI CH] with the MIDI/bus ID of the DA-98.

MIDI Timepiece A/V Setup

For tandem communication between the two WR-DA7s, establish connections from Port 1 OUT to

Port 2 IN and from Port 2 OUT to Port 1 IN.

To have the two WR-DA7s receive MTC from the DA-98, establish connections from Port 3 OUT to

Port 1 IN and to Port 2 IN.

To have the Macintosh (for MIDI sequencer) receive MTC from the DA-98, establish a connection

from Port 3 OUT to the computer.

For MMC control of the DA-98 by the master, establish a route from Port 1 OUT to Port 3 IN.

To control the MIDI sampler and MIDI keyboard with the Macintosh MIDI sequencer (Performer),

establish connections from Port 4 and Port 5 IN and OUT to the computer.  In this case, discon-

nect the routes from the computer to Port 1 and Port 2 to make the communications of the two

WR-DA7s independent.

Macintosh (for Expansion Software) Setup

The serial ports cannot be used for OMS and Free MIDI.  It is recommended, therefore, that they

be disabled using the computer's extension manager.

Macintosh (for MIDI Sequencer) Setup

To have the computer recognize the MIDI Timepiece A/V  and various MIDI devices using Free

MIDI.

If OMS is installed, there is a possibility of a conflict.  It is recommended that it be disabled using

the extension manager.

Expansion Software Setup

Select [Preference] from the Edit menu and open the dialog box.

Select [General], then set [Number of Console] to [2].

Select [Port Setup], then both [Modem] and [Printer] in the Automation Port area.  Also set the

[Sync Source] to [WR-DA7 Timecode Input].

When [OK] is pressed in the [Preference] dialog box, the expansion software loads the setup data

of the master and slave.

To receive timecode set [Sync Source] to [WR-DA7 Timecode Input] in the Preference Port Setup

item of the Edit menu.  Then, enter a check mark at [Receive Timecode] on the Real-time menu.
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MIDI Sequencer (Digital Performer) Setup

To receive MTC from the DA-98 through the MIDI Timepiece A/V , set the Sync Port to [Modem] in

the Receive Sync area in the Basic menu, and set the [Type of Sync] to [MTC, DTL or DTLe].

Then, set the [Slave to External Sync] to [ON] in the Basic menu and press the [Play] button on

the control panel.  When MTC is received from the MIDI Timepiece A/V, Digital Performer time-

code begins to run.
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System Configuration-17
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